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Technologies d’échantillons et d’analyses QIAGEN 
QIAGEN est le premier fournisseur de technologies novatrices d’échantillons et 
d’analyses, permettant d’isoler et de détecter le contenu de n’importe quel 
échantillon biologique. Nos produits et services ultramodernes de grande 
qualité garantissent un succès total, de l’échantillon jusqu’au résultat. 

QIAGEN fixe les normes en matière de : 

 purification d’ADN, d’ARN et de protéines ; 

 analyses d’acides nucléiques et de protéines ; 

 recherche micro-ARN et interférence ARN ; 

 automatisation des technologies d’échantillons et d’analyses. 

Notre mission est de permettre à notre clientèle de réussir et d’accomplir des 
progrès décisifs. Pour plus d'informations, visitez www.qiagen.com. 
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Contenu du kit 

Kit Investigator ESSplex Plus (100) (400) 

Référence 381535 381537 

Nombre de réactions de 25 μl 100 400 

Mélange réactionnel rapide* 750 μl 2 x 1 500 μl 

Mélange d'amorces ESSplex Plus 250 μl 4 x 250 μl 

ADN témoin XY13 (2 ng/μl) 10 μl 10 μl 

ADN étalon de taille 550 (BTO) 50 μl 200 μl 

Échelle allélique ESSplex Plus 25 μl 4 x 25 μl 

Eau exempte de nucléase 2 x 1,9 ml 5 x 1,9 ml 

Carte de protocole 1 1 
 

* Contient de la polymérase Taq, du dNTP, du MgCl2 et de l'albumine sérique bovine. 

Stockage 
Le kit Investigator ESSplex Plus est expédié sur glace sèche. Dès la réception, le 
stocker à –20 °C dans un congélateur à température constante. Éviter la 
congélation et la décongélation répétées. Le mélange d'amorces et l'échelle 
allélique doivent être tenus à l'abri de la lumière. Il convient de stocker les 
échantillons d'ADN et les réactifs post-PCR (échelle allélique et ADN étalon de 
taille) séparément des réactifs de PCR. Dans ces conditions, les composants 
sont stables jusqu’à la date limite d'utilisation figurant sur le kit. 

Une fois ouvert, le kit Investigator ESSplex Plus doit être stocké entre 4 et 8 °C 
pour une durée maximale de 2 semaines. 

Limitations de l’utilisation du produit 
Le kit Investigator ESSplex Plus est prévu pour des applications de biologie 
moléculaire dans les domaines des analyses médicolégales, de la recherche 
d'identité et de la recherche de paternité. Ce produit n'est pas destiné au 
diagnostic, à la prévention ni au traitement d'une maladie. 

Les produits doivent être manipulés avec le plus grand soin et la plus grande 
attention. Nous recommandons à tous les utilisateurs des produits QIAGEN de 
respecter les directives NIH concernant les expériences relatives à l’ADN 
recombiné, ou toute autre directive applicable. 
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Garantie des produits et garantie de satisfaction 
QIAGEN garantit la performance de tous ses produits de la manière décrite 
dans sa documentation. L’acheteur doit déterminer la pertinence du produit 
pour son usage particulier. Si un produit n’offre pas une performance 
satisfaisante pour toute autre raison qu’un mauvais usage, QIAGEN le 
remplacera gratuitement ou remboursera le prix d’achat. Nous nous réservons 
le droit de changer, altérer ou modifier un produit pour améliorer sa 
performance et son esthétique. Si un produit QIAGEN ne répond pas aux 
attentes, appeler le Service technique ou le distributeur local. Nous proposons 
au choix le remboursement ou l'échange du produit. Des conditions distinctes 
s’appliquent aux instruments scientifiques, produits de services et produits 
expédiés sur glace sèche de QIAGEN. Se renseigner pour en savoir plus. 

Une copie des conditions générales de QIAGEN peut être obtenue sur 
demande et figure également au dos de nos factures. Pour toute question sur 
les spécifications ou la performance des produits, appeler les Services 
techniques de QIAGEN ou le distributeur local (voir quatrième de couverture ou 
www.qiagen.com). 

Support technique 
Chez QIAGEN, nous sommes fiers de la qualité et de la disponibilité de notre 
support technique. Nos services techniques sont composés de scientifiques 
expérimentés bénéficiant d’un vaste savoir-faire pratique et théorique en ce qui 
concerne les technologies d’échantillons et d’analyses et l’utilisation des 
produits QIAGEN. Pour toute question ou en cas de difficultés concernant le kit 
Investigator ESSplex Plus ou les produits QIAGEN® en général, nous contacter. 

Les clients de QIAGEN constituent une source d’informations majeure relative 
aux utilisations avancées ou spécialisées de nos produits. Ces informations sont 
utiles à d’autres scientifiques ainsi qu’aux chercheurs de chez QIAGEN. Par 
conséquent, ne pas hésiter à nous contacter pour toute suggestion concernant 
la performance des produits ou de nouvelles applications et techniques. 

Pour une assistance technique et plus d'informations, consulter notre Centre 
d'assistance technique à www.qiagen.com/Support ou appeler l'un des 
Départements du service technique de QIAGEN ou des distributeurs locaux (voir 
quatrième de couverture ou le site www.qiagen.com). 

Contrôle qualité 
Conformément au système de gestion de la qualité certifié ISO de QIAGEN, 
chaque lot de kit Investigator ESSplex Plus est testé selon des spécifications 
prédéterminées afin de garantir une qualité constante du produit. 
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Informations de sécurité 
Lors de la manipulation des produits chimiques, toujours porter une blouse de 
laboratoire, des gants jetables et des lunettes de protection adéquats. Pour plus 
d’informations, consulter les fiches de données de sécurité (FDS) appropriées. 
Elles sont disponibles en ligne au format PDF (pratique et compact) à l’adresse 
www.qiagen.com/support/MSDS.aspx où il est possible de trouver, consulter et 
imprimer les FDS pour chaque kit et élément de kit QIAGEN.  

Informations d’urgence 24 heures sur 24 

Des informations médicales d’urgence en anglais, français et allemand peuvent 
être obtenues 24 heures sur 24 auprès du : 

Centre d’information Antipoison, Mayence, Allemagne 

Tél : +49-6131-19240 
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Introduction 
Le kit Investigator ESSplex Plus est prévu pour la PCR multiplexe dans les 
analyses médicolégales. Les 15 marqueurs minisatellites polymorphes 
recommandés par l'ENFSI (European Network of Forensic Science Institutes) et 
l'EDNAP (European DNA Profiling Group) dans le cadre du nouvel ensemble 
européen de référence de loci (D1S1656, D2S441, D2S1338, D3S1358, 
D8S1179, D10S1248, D12S391, D16S539, D18S51, D19S433, D21S11, 
D22S1045, FGA [FIBRA], TH01 [TC11] et vWA) ainsi que l'amélogénine propre 
à chaque genre sont amplifiés simultanément.  

Le kit a été développé spécifiquement pour l'obtention rapide et fiable de profils 
ADN à partir de sang, de prélèvements buccaux ou de taches repérées par le 
service médicolégal. Le kit exploite la technologie de PCR à cycle court de 
QIAGEN qui permet de réaliser l'amplification en 90 minutes et fournit des 
résultats très fiables grâce à une chimie résistante aux inhibiteurs. Les amorces 
sont rendues fluorescentes à l'aide de l'un des colorants suivants : 

 6-FAM™ : amélogénine, TH01, D3S1358, vWA, D21S11 

 BTG : D16S539, D1S1656, D19S433, D8S1179, D2S1338 

 BTY : D10S1248, D22S1045, D12S391, FGA 

 BTR : D2S441, D18S51 

La quantité optimale d'ADN dans des conditions normales est de 0,2 à 0,5 ng. 
Des validations en interne ont démontré que des résultats fiables peuvent être 
obtenus avec moins de 0,1 ng d'ADN. 

Le kit Investigator ESSplex Plus a été validé à l'aide du thermocycleur 
GeneAmp® 9700 Gold et du séquenceur de gènes Applied Biosystems® 3500. 

Tableau 1 indique les loci des marqueurs microsatellites ainsi que leur carte 
chromosomique, les motifs répétés et les allèles conformes aux 
recommandations de l'ISFG (International Society for Forensic Genetics) sur 
l'utilisation des marqueurs microsatellites (Bär et al., 1997). La nomenclature 
des loci des marqueurs microsatellites D10S1248 et D22S1045 est conforme à 
celle de Hill et al. (2008). 

Pour en savoir plus sur les microvariants non inclus dans l'échelle allélique du 
kit Investigator ESSplex Plus, consulter le site Web du NIST (National Institute of 
Standards and Technology) à l'adresse www.cstl.nist.gov/biotech/strbase/. 
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Tableau 1. Informations spécifiques au locus pour le kit Investigator 
ESSplex Plus 

 
 
Locus 

Numéro 
d'accession 
GenBank® 

 
Motif répété 
de l'allèle de référence 

 
Carte 
chromosomique 

Amélogénine X M55418 – Xp22.1-22.3 

Amélogénine Y M55419 – Yp11.2 

D1S1656 NC_000001.9 [TAGA]16 

[TGA][TAGA][TAGG]1[TG]
5 

1q42 

D2S441 AL079112 [TCTA]12 2p14 

D2S1338 G08202 [TGCC]6[TTCC]11 2q35 

D3S1358 11449919 TCTA [TCTG]2 [TCTA]15 3p25.3 

D8S1179 G08710 [TCTA]12 8q23.1-23.2 

D10S1248 AL391869 [GGAA]13 10q26.3 

D12S391 G08921 [AGAT]5 GAT [AGAT]7 

[AGAC]6 AGAT 
12p13.2 

D16S539 G07925 [GATA]11 16q24.1 

D18S51 L18333 [AGAA]13 18q21.3 

D19S433 G08036 AAGG [AAAG] AAGG 
TAGG [AAGG]11 

19q12 

D21S11 AP000433 [TCTA]4 [TCTG]6 [TCTA]3 

TA [TCTA]3 TCA [TCTA]2 

TCCATA [TCTA]11 

21q21.1 

D22S1045 AL022314 [ATT]14 ACT [ATT]2 22q12.3 

FGA (FIBRA) M64982 [TTTC]3 TTTTTTCT 
[CTTT]13 CTCC [TTCC]2 

4q28.2 

TH01 (TC11) D00269 [TCAT]9 11p15.5 

vWA M25858 TCTA [TCTG]4 [TCTA]13  12p13.31 
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Équipement et réactifs devant être fournis par 
l’utilisateur 
Lors de la manipulation des produits chimiques, toujours porter une blouse de 
laboratoire, des gants jetables et des lunettes de protection adéquats. Pour plus 
d’informations, consulter les fiches de données de sécurité (FDS) appropriées, 
disponibles auprès du fournisseur du produit. 

 Formamide Hi-Di™, 25 ml (Applied Biosystems, référence 4311320) 

 Matrices étalons BT5 pour les séquenceurs monocapillaires tels qu'ABI 
PRISM® 310 (voir la rubrique « Pour commander », page 69). 

 Matrices étalons BT5 pour les séquenceurs multicapillaires tels qu'ABI 
PRISM 3100/3130 et Applied Biosystems 3500 (voir la rubrique « Pour 
commander », page 69). 

 Pipettes et cônes de pipettes 

L'un des séquenceur de gènes suivants : 
ABI PRISM 310 
ABI PRISM 3100-Avant/3100 
ABI PRISM 3130/3130x1 
Applied Biosystems 3500/3500xL pour l'identification humaine 

 L'un des thermocycleurs de PCR suivants :  
QIAGEN Rotor-Gene® Q 
ABI GeneAmp 9600 ou 9700 
Bio-Rad PTC-200 
Techne TC-512 
Biometra T1 
Eppendorf® Mastercycler® ep 

 Tubes ou plaques de PCR 

Logiciel d'analyse de validité des produits d'identification humaine 

Les kits pour PCR pour l'identification humaine Investigator nécessitent un 
étalonnage avec une échelle allélique. Par conséquent, le logiciel utilisé doit 
être compatible avec les produits d'identification humaine destinés à des 
applications médicolégales. Nous recommandons les logiciels suivants : 
IDproof, Investigator IDproof Mixture, GeneMapper® ID, GeneMapper ID-X ou 
Genotyper®. Les fichiers de modèles Investigator facilitent l'analyse des données 
et sont compatibles avec les logiciels précités. 
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Protocole : Amplification par PCR 
Ce protocole s'applique à l'amplification par PCR des loci de marqueurs 
microsatellites d'échantillons médicolégaux à l'aide du kit Investigator ESSplex 
Plus. 

Remarques importantes avant de commencer 

 Préparer tous les mélanges réactionnels dans une zone séparée de celle 
utilisée pour l'extraction d'ADN et l'analyse du produit de PCR (post-PCR). 

 Utiliser des cônes jetables munis de filtres hydrophobes afin de minimiser 
le risque de contamination croisée. 

Avant de commencer 

 Avant d'ouvrir les tubes de composants pour la PCR, les passer au vortex 
puis les centrifuger brièvement pour rassembler le contenu au fond des 
tubes. 

 La quantité recommandée d'ADN dans des conditions normales est de 
0,5 ng. Des validations en interne ont démontré que des résultats probants 
peuvent être obtenus avec 0,2 à 2 ng d'ADN et des résultats fiables avec 
moins de 0,1 ng d'ADN. 

Procédure 

1. Décongeler les composants pour la PCR et la matrice d'acide 
nucléique. 
Mélanger soigneusement avant utilisation. 

2. Préparer un mélange maître à partir du mélange réactionnel rapide 
et du mélange d'amorce comme indiqué au Tableau 2. 
Ce mélange contient tous les composants nécessaires à la PCR à l'exception 
de la matrice d'ADN (échantillon) et de l'eau exempte de nucléase. 

Préparer un volume de mélange réactionnel supérieur de 10 % au volume 
requis pour le nombre total de réactions de PCR à réaliser. Ce nombre doit 
comprendre les réactions avec les témoins positif et négatif.  

3. Mélanger soigneusement et distribuer des volumes adéquats dans 
des tubes de PCR ou les puits d'une plaque de PCR. 

4. Ajouter la matrice d'ADN et l'eau exempte de nucléase au mélange 
maître afin d'obtenir un volume final d'échantillon de 25 μl.  

5. Préparer les témoins positif et négatif. 
Témoin positif : Diluer la solution mère à 2,0 ng/μl d'ADN témoin XY13 à 
0,5 ng/μl dans un volume adapté d'eau exempte de nucléase. Utiliser 
0,5 ng d'ADN témoin XY13 dilué par réaction. 
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Témoin négatif : Utiliser de l'eau exempte de nucléase au lieu de la matrice 
d'ADN pour la réaction. 

Tableau 2. Préparation de la réaction 

Composant Volume par réaction 

Mélange réactionnel rapide  7,5 μl 

Mélange d'amorces 2,5 μl 

Eau exempte de nucléase (ajoutée à 
l'Étape 4) 

Variable 

Matrice d'ADN (ajoutée à l'Étape 4) Variable 

Volume total  25 μl 
 

 

6. Programmer le thermocycleur conformément aux instructions du 
fabricant et aux conditions décrites au Tableau 3. 
Remarque : Pour le thermocycleur GeneAmp 9700 avec le bloc 
aluminium, utiliser le paramètre "Std Mode" (Mode standard) et pour le 
thermocycleur GeneAmp avec le module argent plaqué argent ou or, 
utiliser le paramètre "Max Mode" (Mode maximum). Ne pas utiliser la 
fonction "9600 Emulation Mode" (Mode d'émulation 9600). 

Tableau 3. Protocole de cycle normalisé recommandé pour tous les 
échantillons d'ADN  

Température Durée Nombre de cycles 

95 °C (démarrage à chaud 
pour activer l'ADN 
polymérase) 

5 min – 

96 °C 

61 °C 

10 s 

120 s 

 

30 cycles 

10 °C ∞ – 
 

 

7. Une fois le cycle terminé, stocker les échantillons à –20 °C à l'abri de 
la lumière ou passer directement à l'électrophorèse. 
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Protocole : Électrophorèse à l'aide du séquenceur de 
gènes ABI PRISM 310 
Pour les instructions générales sur la configuration de l'appareil, la génération 
de la matrice et l'application du logiciel GeneScan® ou GeneMapper® ID, se 
rapporter au Manuel d'utilisation du sÝquenceur de gÜnes ABI PRISM 310. 
L'électrophorèse à l'aide du logiciel GeneScan est décrite ci-dessous.  

Le jeu de filtres virtuels G5 sert à l'application combinée des cinq marqueurs 
fluorescents 6-FAM, BTG, BTY, BTR et BTO. Cette matrice étalon est appelée 
BT5.  

Le matériel requis pour l'électrophorèse est indiqué au Tableau 4. 

Tableau 4. Matériel requis pour l'électrophorèse 

Matériel Spécifications 

Capillaire 47 cm/50 μm (vert) 

Polymère POP-4™ pour séquenceur 310 

Tampon Tampon EDTA 10x pour séquenceur 
 

Génération de la matrice 
Avant d'évaluer la taille des fragments d'ADN à l'aide du jeu de filtres G5, il est 
impératif de générer une matrice portant les cinq marqueurs fluorescents 6-
FAM, BTG, BTY, BTR et BTO (Tableau 5).  

Tableau 5. Cinq marqueurs fluorescents de BT5 

Couleur Matrice étalon 

Bleu (B) 6-FAM 

Vert (G) BTG 

Jaune (Y) BTY 

Rouge (R) BTR 

Orange (O) BTO 
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1. Afin de générer des fichiers de matrice adaptés, il convient de 
procéder à cinq cycles d'électrophorèse, un pour chaque marqueur 
fluorescent. Les cycles doivent être réalisés dans les mêmes 
conditions que ceux des échantillons et des échelles alléliques du kit 
Investigator ESSplex Plus (Tableau 6).  

Tableau 6. Préparation de la matrice pour le séquenceur monocapillaire 
ABI (ABI 310) 

Échantillon de 
matrice 

Composant Volume 

Échantillon de 
matrice 1 

Formamide Hi-Di 

Matrice étalon 6-FAM 

12,0 μl 

1,0 μl 

Échantillon de 
matrice 2 

Formamide Hi-Di 

Matrice étalon BTG 

12,0 μl 

1,0 μl 

Échantillon de 
matrice 3 

Formamide Hi-Di 

Matrice étalon BTY 

12,0 μl 

1,0 μl 

Échantillon de 
matrice 4 

Formamide Hi-Di 

Matrice étalon BTR 

12,0 μl 

1,0 μl 

Échantillon de 
matrice 5 

Formamide Hi-Di 

Matrice étalon BTO 

12,0 μl 

1,0 μl 
 

 
2. Dénaturer pendant 3 min à 95 °C. 
3. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

4. Charger les échantillons sur le plateau. 
5. Créer une fiche d'échantillon et saisir une description.  Le Tableau 7 

présente le programme d'injection pour générer la matrice. 
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Tableau 7. Programme d'injection pour générer la matrice. 

Paramètre Valeur 

« Module File » (Fichier de module) GS STR POP-4 (1 ml) G5 

« Matrix File » (Fichier de matrice) « None » (Aucun) 

« Size Standard » (Étalon de taille)* « None » 

« Injection Time » (Durée d'injection) (s) 5 

« Injection Voltage » (Tension d'injection) (kV) 15 

« Run Voltage » (Tension de cycle) (kV) 15 

« Run Temperature » (Température de cycle) (°C) 60 

« Run Time » (Durée de cycle) (min) 24 
 

* Toujours préparer les matrices étalons sans ADN étalon de taille (BTO). 

Analyse des échantillons de matrice 

1. Exécuter le logiciel GeneScan. 
2. Dans le menu File(Fichier), sélectionner « New » (Nouveau) puis 

« Project » (Projet).  
3. Ouvrir le dossier du cycle en cours et sélectionner « Add Sample 

Files » (Ajouter fichiers d'échantillons). 
4. Sélectionner un échantillon de matrice dans la colonne « Sample 

File » (Fichier d'échantillon). 
5. Cliquer sur « Sample » (Échantillon) puis sur « Raw Data » (Données 

brutes). 
6. Vérifier que la ligne de base des échantillons de matrice est plane. 

Comme le montre la figure ci-dessous, il doit y avoir au moins 5 pics 
avec des hauteurs de 1000 à 4000 RFU pour chaque échantillon de 
matrice. 
Remarque : La plage optimale est de 2 000 à 4 000 RFU. 
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Électrophérogramme avec les données brutes de la matrice étalon 6-FAM. 

 

7. Sélectionner une plage d'analyse présentant une ligne de base plane 
et réinjecter l'échantillon de matrice si nécessaire. 

8. Noter les valeurs de début et de fin (points de données) de la plage 
d'analyse, par exemple 3200 et 5500 respectivement. 

9. Calculer la différence entre la valeur de début et la valeur de fin, par 
exemple 5500–3200=2300 points de données. 

Génération d'une matrice 

1. Dans le menu File, sélectionner « New » puis « Matrix » (Matrice). 
2. Importer les échantillons de matrice pour tous les colorants (B, G, Y, 

R et O). 
3. Saisir une valeur de début dans le champ « Start At » (Début), par 

exemple 3200. 
4. Sous « Points », saisir la différence calculée entre la valeur de début 

et la valeur de fin, par exemple 2300. 
5. Cliquer sur « OK » pour calculer la nouvelle matrice. 

 

 
Sélection de l'échantillon de matrice 

▼ 3200 points de données (X) 

            5500▼ 
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6. Dans le menu File, sélectionner « Save as » (Enregistrer sous) pour 

enregistrer la matrice dans le dossier des matrices. 
 

 
Nouvelle matrice BT5. 

Vérification de la matrice 

1. Pour vérifier la nouvelle matrice avec les échantillons actuels, dans le 
menu File, sélectionner « New » puis « Project ». 

2. Ouvrir le dossier du cycle concerné et sélectionner « Add Sample 
Files ». 

3. Sélectionner un ou plusieurs échantillons dans la colonne Sample 
File. 

4. Cliquer sur « Sample » puis sur « Install New Matrix » (Installer 
nouvelle matrice) pour ouvrir le dossier des matrices puis 
sélectionner la nouvelle matrice. 

5. Réanalyser les échantillons. 
Remarque : Avec la nouvelle matrice, il ne doit pas y avoir de pics de 
remontée entre les panels de colorants (B, G, Y, R, O). 

 
Préparation des échantillons 
1. Préparer un mélange de formamide et d'ADN étalon de taille comme 

indiqué au Tableau 8. 

Tableau 8. Préparation du mélange de formamide et d'ADN étalon de 
taille 

Composant Volume par échantillon 

Formamide Hi-Di 12,0 μl 

ADN étalon de taille 550 (BTO) 0,5 μl 
 

 
2. Pour chaque échantillon à analyser, transférer une aliquote de 

mélange de 12 μl dans un tube. 



 

Manuel du kit Investigator ESSplex Plus   08/2011 17 

3. Ajouter 1 μl de produit de PCR ou d'échelle allélique (dilués, si 
nécessaire). 

4. Dénaturer pendant 3 min à 95 °C. 
5. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

6. Charger les échantillons sur le plateau. 

Configuration du logiciel GeneScan 
Créer une fiche d'échantillon et saisir une description. 

Tableau 9. Programme d'injection pour l'ABI 310 

Composant Valeur 

« Module File » (Fichier de module) GS STR POP-4 (1 ml) G5 

« Matrix File » (Fichier de matrice) par exemple, Matrix BT5 

« Size Standard » (Étalon de taille)* par exemple, SST-BTO_60-500bp 

« Injection Time » (Durée d'injection) (s)  5* 

« Injection Voltage » (Tension d'injection) 
(kV) 

15 

« Run Voltage » (Tension de cycle) (kV) 15 

« Run Temperature » (Température de cycle) 
(°C) 

60 

« Run Time » (Durée de cycle) (min) 28† 
 

* En s'écartant des paramètres standard, la durée d'injection peut être comprise entre 1 et 10 s 
selon le type d'échantillon. Si des échantillons présentent un signal très intense, il est possible 
de sélectionner une durée d'injection plus courte. Dans le cas d'échantillons à faible teneur 
en ADN, une durée d'injection allant jusqu'à 10 s peut être nécessaire.  

† La durée du cycle avec le kit Investigator ESSplex Plus a été modifiée pour pouvoir analyser 
des fragments d'une longueur maximale de 500 pb. 
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Paramètres d'analyse 
Tableau 10 dresse la liste des paramètres d'analyse recommandés. 

Tableau 10. Paramètres d'analyse recommandés pour l'ABI PRISM 310 

Paramètre Valeur 

« Analysis Range » (Plage 
d’analyse) 

« Start » (Début) : 2 000 

« Stop » (Fin) : 10 000 

« Data Processing » 
(Traitement des données) 

« Baseline » (Ligne de base) : « Checked » (Vérifiée) 

« Multi-component » (Multicomposant) : « Checked » 

« Smooth options » (Options de lissage) : « Light » 
(Léger) 

« Peak Detection » 
(Détection des pics) 

« Peak Amplitude Thresholds » (Seuils d’amplitude 
des pics) 

B :*    Y :* 

G :*   R :* 

O :* 

« Min. Peak Half Width » (Largeur mini. à mi-
hauteur) : 2 pt 

« Polynomial Degree » (Degré polynomial) : 3 

« Peak Window Size » (Taille de la fenêtre des pics) : 
11 pt† 

« Size Call Range » (Plage 
d’appel des tailles) 

« Min » (Mini.) : 60 

« Max » (Maxi.) : 550 

« Size Calling Method » 
(Méthode d’appel des 
tailles) 

« Local Southern Method » (Méthode locale de 
Southern) 

« Split Peak Correction » 
(Correction des pics 
dédoublés) 

« None » 

 
* Le seuil d'amplitude des pics (valeur seuil) correspond à la hauteur minimale de pic détectée par 

le logiciel GeneScan ou GeneMapper ID. Les seuils sont généralement de 50 à 200 RFU et il 
revient au laboratoire de les déterminer individuellement. Recommandation : Il convient que la 
hauteur minimale de pic soit trois fois plus élevée que le bruit de fond de la ligne de base. 

† Seul le paramètre Peak Window Size diffère des valeurs par défaut d'Applied Biosystems pour 
l'analyse d'identification humaine. 
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Remarque : Pour en savoir plus sur l'utilisation des fichiers de modèles 
recommandés comme paramètres d'analyse, consulter le guide d'utilisation des 
fichiers de modèles Investigator concerné (Genotyper®, GeneMapper ID ou 
GeneMapper ID-X).  
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Protocole : Électrophorèse à l'aide du séquenceur de 
gènes ABI PRISM 3100-Avant/3100 
Pour des instructions détaillées sur la configuration de l'appareil, l'étalonnage 
spectral, l'application du logiciel ABI PRISM 3100 Data Collection version 1.01 
ou 1.1 et le logiciel GeneScan, consulter le Manuel d'utilisation du séquenceur 
de gènes ABI PRISM 3100-Avant/3100 (ABI PRISM 3130/3130xl Genetic 
Analyzers Getting Started Guide).  

L'ABI 3100-Avant est un séquenceur à 4 capillaires et l'ABI 3100 un séquenceur 
à 16 capillaires.  

Le jeu de filtres virtuels G5 sert à l'application combinée des cinq marqueurs 
fluorescents 6-FAM, BTG, BTY, BTR et BTO. Cette matrice étalon est appelée 
BT5.  

Le matériel requis pour l'électrophorèse est indiqué au Tableau 11. 

Tableau 11. Matériel requis pour l'électrophorèse 

Matériel Spécifications 

Capillaire Jeu de capillaires de 36 cm pour séquenceur 3100-
Avant/3100 

Polymère Polymère POP-4 pour séquenceur 3100 

Tampon Tampon EDTA 10x pour séquenceur 
 

Étalonnage spectral et génération de matrice 
Un bon étalonnage spectral est crucial pour évaluer les systèmes multicolores 
avec le séquenceur ABI PRISM 3100-Avant/3100. Il convient de le réaliser avant 
l'analyse de la taille des fragments. La procédure d'étalonnage génère une 
matrice utilisée pour corriger le chevauchement des spectres d'émission de 
fluorescence des colorants.  

L'étalonnage spectral comprend les étapes suivantes : 

 Préparation des étalons 

 Chargement des étalons sur une plaque de réactions à 96 puits (un 
échantillon par capillaire) 

 Saisie de la composition de la plaque 

 Réalisation d'un cycle d'étalonnage spectral et vérification de la matrice 
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Préparation des étalons 

Exemple pour séquenceur à 4 capillaires (ABI 3100-Avant) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 12. 

Tableau 12. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 4 capillaires 

Composant Volume 

Formamide Hi-Di 60 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

5 μl 

 

 
2. Charger 12 μl de mélange sur une plaque à 96 puits, par exemple 

en position A1-D1. 
3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

Exemple pour séquenceur 16 capillaires (ABI 3100) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 13. 

Tableau 13. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 16 capillaires 

Composant Volume 

Formamide Hi-Di 204 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

17 μl 

 

 
2. Charger 12 μl de mélange sur une plaque à 96 puits, par exemple 

en positions A1-H1 et A2-H2. 
3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
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Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

Réalisation d'un cycle d'étalonnage spectral 

Le fichier de paramètres pour le jeu de colorants G5 doit être modifié une fois 
pour réussir l'étalonnage avec le logiciel Data Collection version 1.0.1 ou 1.1. 

Paramètre spectral 

1. Pour modifier les valeurs du fichier de paramètres, se rendre à 
l'emplacement suivant : 
D:\AppliedBio\Support Files\Data Collection 
SupportFiles\CalibrationData\Spectral Calibration\ParamFiles . 

2. Sélectionner « MtxSTD{Genescan_SetG5} » pour ouvrir le fichier PAR. 
3. Modifier la valeur du paramètre « Condition Bounds Range » 

(Gamme des limites de condition) sur [1,0; 20,0]. 
4. En cas d'échec de l'étalonnage, modifier également les paramètres 

Sensitivity (Sensibilité) sur 0,1 et Quality (Qualité) sur 0,8. 
5. Dans le menu File, sélectionner « Save As » et enregistrer le fichier 

de paramètres sous un nouveau nom, par exemple 
MtxStd{Genescan_SetG5_BT5}.par. 
Remarque : Utiliser toujours ce fichier de paramètres pour les cycles 
d'étalonnage spectral avec la matrice étalon BT5 de QIAGEN. 

Définition de la plaque dans Plate Editor pour l'étalonnage spectral 

1. Placer la plaque à 96 puits sur le plateau d'un passeur automatique 
d'échantillons. 

2. Exécuter le logiciel ABI PRISM 3100 Data Collection. 
3. Dans Plate View (Affichage de plaque), cliquer sur « New » pour 

ouvrir la boîte de dialogue Plate Editor (Éditeur de plaques). 
4. Nommer la plaque. 
5. Sélectionner un étalonnage spectral. 
6. Sélectionner « 96-Well » (96 puits) comme valeur du paramètre Plate 

Type (Type de plaque) et cliquer sur « Finish » (Terminer). 
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Tableau 14. Définition de la plaque dans Plate Editor pour l'étalonnage 
spectral  

Paramètre Valeur 

« Sample Name » (Nom de 
l'échantillon) 

Saisir le nom des échantillons de 
matrice 

« Dye Set » (Jeu de 
colorants) 

G5 

« Spectral Run Module » 
(Module de cycle 
d’étalonnage) 

Par défaut (par exemple, 
Spect36_POP4) 

« Spectral Parameters » 
(Paramètres spectraux) 

MtxStd{GeneScan_SetG5_BT5}.par 
(paramètres créés précédemment) 

 
 
7. Cliquer sur l'en-tête de colonne pour sélectionner la colonne entière 

puis, dans le menu Edit (Édition), sélectionner « Fill Down » (Remplir 
vers le bas) pour appliquer les informations aux échantillons 
sélectionnés. Cliquer sur « OK » pour valider. 

8. Lier la plaque de réaction sur le plateau du passeur automatique 
d'échantillons à l'ID de plaque créé puis lancer le cycle. 

9. À la fin du cycle, vérifier dans la boîte de dialogue Spectral 
Calibration Result (Résultat de l'étalonnage spectral) que 
l'étalonnage a réussi pour tous les capillaires (étiquette A).  
Si certains capillaires sont marqués de la lettre X, consulter le Manuel 
d'utilisation du séquenceur de gènes ABI PRISM (ABI PRISM Genetic Analyzer 
User's Manual). 

10. Cliquer sur « OK » pour confirmer la fin du cycle. 

Vérification de la matrice 

1. Dans le menu Tools (Outils), sélectionner « Display Spectral 
Calibration » (Afficher étalonnage spectral) suivi de « Dye Set » et 
« G5 » pour étudier le profil d'étalonnage spectral de chaque 
capillaire. 

2. La valeur de qualité (Q) doit être supérieure à 0,95 et le nombre 
condition (C) doit être compris entre 1 et 20. Les deux valeurs 
doivent se trouver dans la plage prédéterminée. 
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3. Vérifier que la ligne de base des échantillons de matrice est plane. 
Chaque échantillon de matrice doit être associé à cinq pics de 
hauteur comprise entre 1000 et 5000 RFU. 
Remarque : La plage optimale est de 2000 à 4000 RFU. 

4. Vérifier la nouvelle matrice avec les échantillons actuels. Avec la 
nouvelle matrice, il ne doit pas y avoir de pics de remontée entre les 
panels de colorants (B, G, Y, R et O). 

5. En cas d'échec de l'étalonnage, suivre la section « Paramètre 
spectral », page 22. 

6. Si l'étalonnage a réussi pour tous les capillaires, le dernier fichier 
d'étalonnage pour le jeu de colorants G5 doit être activé 
manuellement. Dans le menu Tools, cliquer sur « Set Active Spectral 
Calibration » (Définir étalonnage spectral actif). 

7. Renommer le fichier d'étalonnage sous Set Matrix Name (Définir 
nom de matrice) (par exemple, BT5_Date d'étalonnage). 

Préparation des échantillons 
1. Préparer un mélange de formamide et d'ADN étalon de taille comme 

indiqué au Tableau 15. 

Tableau 15. Préparation du mélange de formamide et d'ADN étalon de 
taille 

Composant Volume par échantillon 

Formamide Hi-Di 12 μl 

ADN étalon de taille 550 (BTO) 0,5 μl 
 

2. Pour chaque échantillon à analyser, transférer une aliquote de 
mélange de 12 μl dans un tube. 

3. Ajouter 1 μl de produit de PCR ou d'échelle allélique (dilués, si 
nécessaire). 

4. Dénaturer pendant 3 min à 95 °C. 
5. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

6. Charger les échantillons sur le plateau. 
 
Dans la mesure où les injections ont lieu au même moment pour tous les 
capillaires, 4 ou 16 échantillons doivent être pipetés dans la plaque des 
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séquenceurs multicapillaires. Si le nombre d'échantillons analysés est inférieur, 
il est impératif de remplir les positions vides avec 12 μl de formamide Hi-Di. 

Afin d'assurer la fiabilité de la localisation des allèles avec les séquenceurs 
multicapillaires, il convient d'utiliser plusieurs échelles alléliques. 

La température ambiante peut affecter la performance des produits de PCR sur 
les séquenceurs multicapillaires, générant des épaulements ou des 
dédoublements de pics, en particulier à basse température. Veiller à maintenir 
des conditions ambiantes conformes aux recommandations du fabricant de 
l'appareil. 

Configuration du logiciel GeneScan 
1. Modifier le module de cycle par défaut du jeu de colorants G5 une 

fois pour le premier cycle. Sélectionner « Module Editor » (Éditeur de 
modules) pour ouvrir la boîte de dialogue. 

2. Dans le tableau GeneScan, sélectionner le module de cycle adapté 
comme modèle (voir le Tableau 16). 

3. Modifier le paramètre Injection Voltage sur 3 kV et le paramètre 
Injection Time sur 10 s. 

4. Cliquer sur « Save As » et saisir le nom du nouveau module (par 
exemple, 3kV_10s_500bp). Cliquer sur « OK » pour valider. 

5. Cliquer sur « Close » (Fermer) pour quitter Run Module Editor 
(Éditeur de modules de cycle). 
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Tableau 16. Module de cycle 3kV_10s_500bp pour séquenceur 3100-
Avant/3100 

Paramètre Valeur 

« Run Temperature » (°C) Par défaut 

« Cap Fill Volume » (Volume de remplissage des 
capillaires) 

Par défaut 

« Maximum Current » (Courant maximal) (A) Par défaut 

« Current Tolerance » (Tolérance de courant) (A) Par défaut 

« Run Current » (Courant de cycle) (A) Par défaut 

« Voltage Tolerance » (Tolérance de tension) (kV) Par défaut 

« Pre-Run Voltage » (Tension de pré-cycle) (kV) Par défaut 

« Pre-Run Time » (Durée de précycle) (s) Par défaut 

« Injection Voltage » (kV) 3,0 

« Injection Time » (s) 10* 

« Run Voltage » (kV) Par défaut 

« Number of Steps » (Nombre de plateaux) Par défaut 

« Voltage Step Interval » (Intervalle entre deux 
plateaux de tension) 

Par défaut 

« Data Delay Time » (Délai d’attente des données) 
(s) 

Par défaut 

« Run Time » (min) 26† 
 

* En s'écartant des paramètres standard, la durée d'injection peut être comprise entre 1 et 20 s 
selon le type d'échantillon. Si des échantillons présentent un signal très intense, il est possible 
de sélectionner une durée d'injection plus courte. Dans le cas d'échantillons à faible teneur 
en ADN, une durée d'injection allant jusqu'à 20 s peut être nécessaire.  

† La durée du cycle avec le kit Investigator ESSplex Plus a été modifiée pour pouvoir analyser 
des fragments d'une longueur maximale de 500 pb. 

Démarrage du cycle 

1. Placer la plaque à 96 puits préparée sur le plateau d'un passeur 
automatique d'échantillons. 

2. Exécuter le logiciel ABI PRISM 3100 Data Collection. 
3. Dans Plate View, cliquer sur « New » pour ouvrir la boîte de 

dialogue Plate Editor. 
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4. Nommer la plaque. 
5. Sélectionner « GeneScan » comme valeur du paramètre Application 

Type (Type d'application). 
6. Sélectionner « 96-Well » comme valeur du paramètre Plate Type et 

cliquer sur « Finish ». 

Tableau 17. Paramètres dans Plate Editor 

Paramètre Valeur 

« Sample Name » Saisir le nom des échantillons de 
matrice 

« Dyes » (Colorants) O 

« Color Info » (Info sur la couleur) « Ladder » (Échelle) ou « Sample » 

« Project Name » (Nom du projet) par exemple, 3100_Project1 

« Dye Set » G5 

« Run Module » (Module de cycle) 3kV_10s_500bp* 

« Analysis Module 1 » (Module 
d'analyse 1) 

DefaultAnalysis.gsp 

 
* Voir Tableau 16, « Module de cycle 3kV_10s_500bp pour séquenceur 3100-Avant/3100 ». 
 
7. Remplir le tableau dans Plate Editor et cliquer sur « OK ». 
8. Cliquer sur l'en-tête de colonne pour mettre en surbrillance la 

colonne entière puis, dans le menu Edit, sélectionner « Fill Down » 
pour appliquer les informations aux échantillons sélectionnés. 

9. Lier la plaque de réaction sur le plateau du passeur automatique 
d'échantillons à l'ID de plaque créé puis lancer le cycle. 

10. À la fin du cycle, visualiser les données de type Color Data (Données 
couleur) dans l'écran Array View (Affichage du jeu de capillaires) du 
logiciel 3100 Data Collection ou sous forme de fichiers d'échantillons 
analysés sous D:/AppliedBio/3100/DataExtractor/ExtractRuns. 
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Paramètres d'analyse 
Tableau 18 dresse la liste des paramètres d'analyse recommandés. 

Tableau 18. Paramètres d'analyse recommandés pour l'ABI PRISM 3100-
Avant/3100 

Paramètre Valeur 

« Analysis Range » « Start » : 2 000 

« Stop » : 10 000 

« Data Processing » « Baseline » : « Checked » 

« Multi-component » : « Checked » 

« Smooth options » : « Light » 

« Peak Detection » « Peak Amplitude Thresholds » 

B :*    Y :* 

G :*   R :* 

O :* 

« Min. Peak Half Width » : 2 pt 

« Polynomial Degree » : 3 

« Peak Window Size » : 11 pt† 

« Size Call Range » « Min » : 60 

« Max » : 550 

« Size Calling Method » « Local Southern Method » 

« Split Peak Correction » « None » 
 

* Le seuil d'amplitude des pics (valeur seuil) correspond à la hauteur minimale de pic détectée par 
le logiciel GeneScan ou GeneMapper ID. Les seuils sont généralement de 50 à 200 RFU et il 
revient au laboratoire de les déterminer individuellement. Recommandation : Il convient que la 
hauteur minimale de pic soit trois fois plus élevée que le bruit de fond de la ligne de base. 

† Seul le paramètre Peak Window Size diffère des valeurs par défaut d'Applied Biosystems pour 
l'analyse d'identification humaine. 

 
Remarque : Pour en savoir plus sur l'utilisation des fichiers de modèles 
recommandés comme paramètres d'analyse, consulter le guide d'utilisation des 
fichiers de modèles Inverstigator concerné (Genotyper, GeneMapper ID ou 
GeneMapper ID-X). 
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Protocole : Électrophorèse à l'aide du séquenceur de 
gènes ABI PRISM 3130/3130xl 
Pour des instructions détaillées sur la configuration de l'appareil, l'étalonnage 
spectral ou l'application du logiciel ABI PRISM Data Collection version 3.0 et le 
logiciel GeneMapper ID, consulter le Guide de prise en main du séquenceur de 
gènes ABI PRISM 3130/3130xl (ABI PRISM 3130/3130xl Genetic Analyzers 
Getting Started Guide).  

L'ABI 3130 est un séquenceur à 4 capillaires et l'ABI 3130xl un séquenceur à 
16 capillaires. 

Le jeu de filtres virtuels Any5Dye sert à l'application combinée des cinq 
marqueurs fluorescents 6-FAM, BTG, BTY, BTR et BTO. Cette matrice étalon est 
appelée BT5.  

Le matériel requis pour l'électrophorèse est indiqué au Tableau 19. 

Tableau 19. Matériel requis pour l'électrophorèse 

Matériel Spécifications 

Capillaire Jeu de capillaires de 36 cm pour séquenceur 
3130/3130xl 

Polymère Polymère POP-4 pour séquenceur 3130 

Tampon Tampon EDTA 10x pour séquenceur 
 

Étalonnage spectral et génération de matrice 
Avant d'évaluer la taille des fragments d'ADN, il est nécessaire de réaliser un 
étalonnage spectral avec les cinq marqueurs fluorescents 6-FAM, BTG, BTY, 
BTR et BTO pour chaque séquenceur. La procédure d'étalonnage génère une 
matrice utilisée pour corriger le chevauchement des spectres d'émission de 
fluorescence des colorants.  

L'étalonnage spectral comprend les étapes suivantes : 

 Préparation des étalons 

 Chargement des étalons sur une plaque de réactions à 96 puits (un 
échantillon par capillaire) 

 Création d'un protocole d'étalonnage spectral spécifique à l'appareil (dans 
Protocol Manager (Gestionnaire de protocoles)) 

 Définition de la composition des plaques dans l'éditeur de plaque (Plate 
Manager) 

 Réalisation d'un cycle d'étalonnage spectral et vérification de la matrice 
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Préparation des étalons 

Exemple pour séquenceur 4 capillaires (ABI 3130) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 20. 

Tableau 20. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 4 capillaires 

Composant Volume 

Formamide Hi-Di 60 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

5 μl 

 

 
2. Charger 12 μl de mélange sur une plaque à 96 puits, par exemple 

en position A1-D1. 
3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

Exemple pour séquenceur à 16 capillaires (ABI 3130xl) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 21. 

Tableau 21. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 16 capillaires 

Composant Volume 

Formamide Hi-Di 204 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

17 μl 

 

 
2. Charger 12 μl de mélange sur une plaque à 96 puits, par exemple 

en positions A1-H1 et A2-H2. 
3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
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Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

 

 
Réalisation d'un cycle d'étalonnage spectral 
1. Placer la plaque à 96 puits sur le plateau d'un passeur automatique 

d'échantillons. 
2. Dans le logiciel Data Collection, dans Protocol Manager, ouvrir la 

fenêtre « Instrument Protocol » (Protocole de l'appareil). 
3. Cliquer sur « New » pour ouvrir la boîte de dialogue Protocol Editor 

(Éditeur de protocoles). 
4. Renseigner la boîte de dialogue avec les informations fournies au 

Tableau 22 puis cliquer sur « OK ». 

Tableau 22. Protocole d'étalonnage spectral spécifique à l'appareil 

Protocol Editor Valeur 

« Name » (Nom) Utilisateur (par exemple, Spectral36_POP4_BT5) 

« Type » « SPECTRAL » 

« Dye Set » Any5Dye 

« Polymer » (Polymère) Utilisateur (par exemple, POP4)* 

« Array Length » 
(Longueur des capillaires) 

Utilisateur (par exemple, 36 cm)* 

« Chemistry » (Chimie) « Matrix Standard » (Matrice étalon) 

« Run Module » Par défaut (par exemple, Spect36_POP4_1)* 
 

* Dépend du type de polymère et de la longueur des capillaires utilisés. 
 
5. Dans le logiciel Data Collection, dans Plate Manager, cliquer sur 

« New » pour ouvrir la boîte de dialogue New Plate (Nouvelle 
plaque). 

6. Saisir les informations du Tableau 23 puis cliquer sur « OK ». Un 
nouveau tableau s'ouvre automatiquement dans Plate Editor 
(Tableau 24). 
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Tableau 23. Définition de la plaque dans Plate Editor pour l'étalonnage 
spectral (I) 

Boîte de dialogue New Plate Valeur 

« Name » par exemple, Spectral_BT5_date 

« Application » « Spectral Calibration » (Étalonnage 
spectral) 

« Plate Type » « 96-well » 

« Owner Name/ 
Operator Name » (Nom du 
propriétaire/de l’opérateur) 

… 

 
 

Tableau 24. Définition de la plaque dans Plate Editor pour l'étalonnage 
spectral (II) 

Paramètre Valeur 

« Sample Name » Saisir le nom des échantillons de 
matrice 

« Priority » (Priorité) par exemple, 100 

« Instrument Protocol 1 » 
(Protocole spécifique à 
l’appareil 1) 

Spectral36_POP4_BT5 (paramètre 
décrit précédemment) 

 
 
7. Cliquer sur l'en-tête de colonne pour sélectionner la colonne entière 

puis, dans le menu Edit, sélectionner « Fill Down » pour appliquer les 
informations aux échantillons sélectionnés. Cliquer sur « OK » pour 
valider. 

8. Lier la plaque de réaction sur le plateau du passeur automatique 
d'échantillons à l'ID de plaque créé (position A ou B) puis lancer le 
cycle. 
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Électrophérogramme d'étalonnage spectral avec la matrice étalon BT5 sur le 
séquenceur de gènes ABI 3130 

Vérification de la matrice 

1. La valeur de qualité (Q) de chaque capillaire doit être supérieure à 
0,95 et le nombre condition (C) doit être compris entre 1 et 20. 

2. Vérifier que la ligne de base des échantillons de matrice est plane. 
Comme indiqué sur la figure ci-dessus, chaque échantillon de 
matrice doit être associé à cinq pics de hauteur comprise entre 1000 
et 5000 RFU. 
Remarque : La plage optimale est de 2000 à 4000 RFU. 

3. Vérifier la nouvelle matrice avec les échantillons actuels. Avec la 
nouvelle matrice, il ne doit pas y avoir de pics de remontée entre les 
panels de colorants (B, G, Y, R, O). 

4. En cas d'échec de l'étalonnage, utiliser les valeurs optimisées de la 
matrice étalon BT5 et répéter le cycle d'étalonnage. 

5. Si l'étalonnage a réussi pour tous les capillaires, le dernier fichier 
d'étalonnage pour le jeu de colorants Any5Dye est activé 
automatiquement dans Spectral Viewer. Renommer le fichier 
d'étalonnage (par exemple, BT5_Date d'étalonnage). 

 
Préparation des échantillons 
1. Préparer un mélange de formamide et d'ADN étalon de taille comme 

indiqué au Tableau 25. 

   O          R            Y         G       B 
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Tableau 25. Préparation du mélange de formamide et d'ADN étalon de 
taille 

Composant Volume par 
échantillon 

Formamide Hi-Di 12,0 μl 

ADN étalon de taille 550 (BTO) 0,5 μl 
 

 
2. Pour chaque échantillon à analyser, transférer une aliquote de 

mélange de 12 μl dans un tube. 
3. Ajouter 1 μl de produit de PCR ou d'échelle allélique (dilués, si 

nécessaire). 
4. Dénaturer pendant 3 min à 95 °C. 
5. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

6. Charger les échantillons sur le plateau. 
 
Dans la mesure où les injections ont lieu au même moment pour tous les 
capillaires, 4 ou 16 échantillons doivent être pipetés dans la plaque des 
séquenceurs multicapillaires. Si le nombre d'échantillons analysés est inférieur, 
il est impératif de remplir les positions vides avec 12 μl de formamide Hi-Di. 

Afin d'assurer la fiabilité de la localisation des allèles avec les séquenceurs 
multicapillaires, il convient d'utiliser plusieurs échelles alléliques. 

La température ambiante peut affecter la performance des produits de PCR sur 
les séquenceurs multicapillaires, générant des épaulements ou des 
dédoublements de pics, en particulier à basse température. Veiller à maintenir 
des conditions ambiantes conformes aux recommandations du fabricant de 
l'appareil. 

Configuration du logiciel Data Collection 
7. Modifier le module de cycle une fois pour le premier cycle. Dans le 

logiciel Data Collection, dans Module Manager (Gestionnaire de 
modules), cliquer sur « New » pour ouvrir la boîte de dialogue Run 
Module Editor. 

8. Modifier le paramètre Injection Voltage sur 3 kV et le paramètre 
Injection Time sur 10 s (Tableau 26). 

9. Cliquer sur « Save as », nommer le nouveau module de cycle  
(par exemple 3kV_10s_500bp) et valider en cliquant sur « OK ». 
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10. Cliquer sur « Close » pour quitter Run Module Editor. 
Remarque : Modifier les paramètres par défaut du module de cycle de 
« HIDFragmentAnalysis36_POP4_1 » comme indiqué ci-dessous. 

 

Tableau 26. Module de cycle 3kV_10s_500bp pour séquenceur ABI 
3130/3130xl 

Paramètre Valeur 

« Oven Temperature » (Température du four) 
(°C) 

Par défaut 

« Poly Fill Volume » (Volume de remplissage 
du polymère) 

Par défaut 

« Current Stability » (Stabilité du courant) (μA) Par défaut 

« Pre-Run Voltage » (kV) Par défaut 

« Pre-Run Time » (s) Par défaut 

« Injection Voltage » (kV) 3,0 

« Injection Time » (s) 10* 

« Voltage Number of Steps » (Nombre de 
plateaux de tension) 

Par défaut 

« Voltage Step Interval » Par défaut 

« Data Delay Time » (s) Par défaut 

« Run Voltage » (kV) Par défaut 

« Run Time » (s) 1560† 
 

* En s'écartant des paramètres standard, la durée d'injection peut être comprise entre 1 et 20 s 
selon le type d'échantillon. Si des échantillons présentent un signal très intense, il est possible 
de sélectionner une durée d'injection plus courte. Dans le cas d'échantillons à faible teneur 
en ADN, une durée d'injection allant jusqu'à 20 s peut être nécessaire.  

† La durée du cycle avec le kit Investigator ESSplex Plus a été modifiée pour pouvoir analyser 
des fragments d'une longueur maximale de 500 pb. 

Démarrage du cycle 

1. Placer la plaque à 96 puits préparée sur le plateau d'un passeur 
automatique d'échantillons. 

2. Dans le logiciel Data Collection, ouvrir Protocol Manager. 
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3. Dans la fenêtre Instrument Protocol, cliquer sur « New » pour ouvrir 
la boîte de dialogue Protocol Editor puis saisir les informations 
fournies au Tableau 27. 

4. Cliquer sur « OK » pour quitter Protocol Editor. 

Tableau 27. Paramètres du protocole spécifique à l'appareil 

Protocol Editor Valeur 

« Name » Run36_POP4_BT5_26min 

« Type » « REGULAR » (RÉGULIER) 

« Run Module »* 3kV_10s_500bp 

« Dye Set » Any5Dye 
 

* Voir Tableau 26, « Module de cycle 3kV_10s_500bp pour séquenceur ABI 3130/3130xl ». 
 

5. Avant chaque cycle, il est nécessaire de créer une définition de 
plaque. Dans le logiciel Data Collection, dans Plate Manager, cliquer 
sur « New » pour ouvrir la boîte de dialogue New Plate. 

6. Saisir les informations fournies au Tableau 28. 

Tableau 28. Définition de la plaque dans Plate Editor de GeneMapper (I) 

Protocol Editor Valeur 

« Name » par exemple, Plate_BT5_Date 

« Application » Sélectionner l'application 
GeneMapper 

« Plate type » « 96-Well » 

« Owner Name/ 
Operator Name » 

… 

 
 
7. Cliquer sur « OK ». Un nouveau tableau s'ouvre automatiquement 

dans Plate Editor (Tableau 29). 
8. Cliquer sur l'en-tête de colonne pour sélectionner la colonne entière 

puis, dans le menu Edit, sélectionner « Fill Down » pour appliquer les 
informations à tous les échantillons sélectionnés. Cliquer sur « OK ». 

9. Dans Run Scheduler (Programmateur de cycles), cliquer sur « Find 
All » (Tout trouver) et sélectionner « Link » (Lier) pour lier la plaque 
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de réaction sur le plateau du passeur automatique d'échantillons à 
la plaque qui vient d'être créée (position A ou B). 

Tableau 29. Définition de la plaque dans Plate Editor de GeneMapper 
(II) 

Paramètre Valeur 

« Sample Name » Saisir le nom des échantillons. 

« Priority » par exemple, 100 (par défaut) 

« Sample Type » (Type 
d’échantillon) 

« Sample » ou « Allelic Ladder » (Échelle 
allélique) 

« Size Standard » par exemple, SST-BTO_60-500bp 

« Panel » par exemple, ESSplex_Panels 

« Analysis Method » (Méthode 
d’analyse) 

par exemple, Analysis_HID_3130 

« Snp Set » (Jeu de SNP) – 

« User-defined 1-3 » (Défini 
par l'utilisateur 1 à 3) 

– 

« Results Group 1 » (Groupe 
de résultats 1) 

(Sélectionner le groupe de résultats.) 

« Instrument Protocol 1 » Run36_POP4_BT5_26min (paramètre décrit 
précédemment) 

 
 
10. Lancer le cycle. 
11. Pendant le cycle, afficher l'information Error Status (État d'erreur) 

dans le journal Event Log (Journal des événements) ou analyser la 
qualité des données brutes pour chaque capillaire dans Capillaries 
Viewer (Afficheur de capillaires) ou Cap/Array Viewer (Afficheur de 
capillaires/jeu de capillaires). 

12. Afficher une vue d'ensemble des données dans Run History 
(Historique des cycles) ou Cap/Array Viewer dans le logiciel Data 
Collection.  
Les données de cycle sont enregistrées dans le dossier de cycle du groupe 
de résultats précédemment choisi. 
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Paramètres et méthode d'analyse 
Tableau 30 dresse la liste des paramètres d'analyse recommandés pour la fiche 
de travail « Peak Detector » (Détecteur de pics). 

Tableau 30. Paramètres recommandés pour l'ABI PRISM 3130/3130xl 

Paramètre Valeur 

« Peak Detection Algorithm » 
(Algorithme de détection des 
pics) 

« Advanced » (Avancé) 

« Ranges » (Plages) « Analysis » (Analyse) : « Partial Range » 
(Plage partielle) 

« Start Point » (Début) : 2 000 ; « Stop Point » 
(fin) : 10 000 

« Sizing » (Taille) : « All Sizes » (Toutes les 
tailles) 

« Smoothing and 
Baselining » (Lissage et ligne 
de base) 

« Smoothing » (Lissage) : « Light »  

« Baseline Window » (Fenêtre de la ligne de 
base) : 51 pt 

« Size Calling Method » « Local Southern Method » 

« Peak Detection » « Peak Amplitude Thresholds » 

B :*    Y :* 

G :*   R :* 

O :* 

« Min. Peak Half Width » : 2 pt 

« Polynomial Degree » : 3 

« Peak Window Size » : 11 pt† 

« Slope Thresholds » (Seuils de la pente) : 0,0 
 

* Le seuil d'amplitude des pics (valeur seuil) correspond à la hauteur minimale de pic détectée 
par le logiciel GeneMapper ID. Les seuils sont généralement de 50 à 200 RFU et il revient 
au laboratoire de les déterminer individuellement. Recommandation : Il convient que la 
hauteur minimale de pic soit trois fois plus élevée que le bruit de fond de la ligne de base. 

† Seul le paramètre Peak Window Size diffère des valeurs par défaut d'Applied Biosystems pour 
l'analyse d'identification humaine. 

 
Remarque : Pour en savoir plus sur l'utilisation des fichiers de modèles 
recommandés comme paramètres d'analyse, consulter le guide d'utilisation des 
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fichiers de modèles Investigator concerné (Genotyper, GeneMapper ID ou 
GeneMapper ID-X). 
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Protocole : Électrophorèse à l'aide du séquenceur de 
gènes Applied Biosystems 3500/3500xL 
Pour des instructions détaillées sur la configuration de l'appareil, l'étalonnage 
spectral ou l'application du logiciel Applied Biosystems 3500 Series Data 
Collection version 1.0 et le logiciel GeneMapper ID-X version 1.2, consulter le 
Guide d'utilisation du séquenceur de gènes Applied Biosystems 3500/3500xL 
(Applied Biosystems 3500/3500xL Genetic Analyzers User Guide).  

L'ABI 3500 est un séquenceur à 8 capillaires et l'ABI 3500xl un séquenceur à 
24 capillaires. 

Le jeu de filtres virtuels AnyDye sert à l'application combinée des cinq 
marqueurs fluorescents 6-FAM, BTG, BTY, BTR et BTO. Cette matrice étalon est 
appelée BT5.  

Le matériel requis pour l'électrophorèse est indiqué au Tableau 31. 

Tableau 31. Matériel requis pour l'électrophorèse 

Matériel Spécifications 

Capillaire Jeu de capillaires de 36 cm pour séquenceur 
3500/3500xl 

Polymère POP-4 pour séquenceur 3500/3500xL  

Tampon Tampon EDTA 10x pour séquenceur 3500/3500xL 
 

Étalonnage spectral et génération de matrice 
Avant d'évaluer la taille des fragments d'ADN, il est nécessaire de réaliser un 
étalonnage spectral avec les cinq marqueurs fluorescents 6-FAM, BTG, BTY, 
BTR et BTO pour chaque séquenceur (Tableau 32). La procédure d'étalonnage 
génère une matrice utilisée pour corriger le chevauchement des spectres 
d'émission de fluorescence des colorants.  

L'étalonnage spectral comprend les étapes suivantes : 

 Préparation de l'appareil 

 Préparation du jeu de colorants BT5 

 Préparation de la plaque d'étalonnage 

 Montage de la plaque et chargement sur l'appareil 

 Réalisation d'un cycle d'étalonnage spectral 

 Vérification de la matrice 
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Préparation de l'appareil 

Avant de procéder à l'étalonnage spectral, vérifier que l'étalonnage spatial a été 
réalisé. Ce procédé est décrit en détail dans le Guide d'utilisation des 
séquenceurs de gènes Applied Biosystems 3500/3500xL (Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide).  

Tableau 32. Cinq marqueurs fluorescents de BT5 

Couleur Matrice étalon 

Bleu (B) 6-FAM 

Vert (G) BTG 

Jaune (Y) BTY 

Rouge (R) BTR 

Orange (O) BTO 
 

Préparation du jeu de colorants BT5 

1. Avant l'étalonnage spectral, un jeu de colorants pour la matrice 
étalon BT5 doit être configuré. Pour créer un nouveau jeu de 
colorants, aller dans « Library » (Bibliothèque) et sélectionner 
« Analyze » (Analyser) puis « Dye Sets » et cliquer sur « Create » 
(Créer). 

2. Renseigner le champ « Dye Set Name » (Nom du jeu de colorants), 
par exemple BT5. 

3. Sélectionner la valeur « Matrix Standard » pour le paramètre 
Chemistry et « AnyDye Template » (Matrice AnyDye) pour le 
paramètre Dye Set Template. 

4. Désactiverla case violette dans le champ « Arrange Dyes » 
(Organiser les colorants). Vérifier que toutes les autres couleurs sont 
activées. 

5. Sous « Calibration Peak Order » (Ordre des pics d'étalonnage), les 
couleurs doivent être organisées comme suit : 5 – bleu, 4 – vert, 3 – 
jaune, 2 – rouge et 1 – orange. 

6. Ne modifier pas les valeurs « Parameter » (Paramètre). 
7. Cliquer sur « Save » (Enregistrer) pour confirmer les modifications. 
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Configuration du jeu de colorants BT5. 

Préparation de la plaque d'étalonnage 

Exemple pour séquenceur à 8 capillaires (AB 3500) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 33. 

Tableau 33. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 8 capillaires 

Composant Volume 

Formamide Hi-Di 90 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

10 μl 
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2. Charger 10 μl de mélange sur une plaque à 96 puits, par exemple 
en position A1-H1. 

3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

Exemple pour séquenceur à 24 capillaires (AB 3500xl) 

1. Préparer un mélange de formamide et de matrice étalon BT5 comme 
indiqué au Tableau 34. 

Tableau 34. Préparation du mélange de formamide et de matrice étalon 
BT5 pour séquenceur à 24 capillaires 

Composant Volume 

Formamide Hi-Di 225 μl 

Matrice étalon BT5 pour séquenceur 
multicapillaire 

25 μl 

 

 
2. Charger 10 μl de mélange sur une plaque à 96 puits, par exemple 

en position A1-H1m A2-H2 et A3-H3. En cas d'utilisation d'une 
plaque à 384 puits, charger 10 μl des mélanges dans les colonnes 1, 
3 et 5 des rangées A, C, E, G, I, K, M et O. 

3. Dénaturer pendant 3 min à 95 °C. 
4. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

Montage de la plaque et chargement sur l'appareil 

Les étapes à suivre sont décrites en détail dans le Guide d'utilisation des 
séquenceurs de gènes Applied Biosystems 3500/3500xL (Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide). 

Réalisation d'un cycle d'étalonnage spectral 

L'étalonnage spectral peut commencer une fois que les plaques contenant le 
mélange d'étalonnage spectral sont placées sur le plateau du passeur 
automatique d'échantillons. 
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1. Pour accéder à l'écran Spectral Calibration, sélectionner 
« Maintenance » sur le tableau de bord du logiciel 3500 Series Data 
Collection. 

2. Le nombre de puits de la plaque d'étalonnage spectral et leur 
emplacement sur l'appareil doivent être spécifiés. 

3. Sélectionner la valeur « Matrix Standard » pour le paramètre 
Chemistry Standard (Étalon de chimie) et « BT5 » pour le paramètre 
Dye Set. 

4. (Facultatif) Activer « Allow Borrowing » (Autoriser l'emprunt). 
5. Cliquer sur « Start Run » (lancer le cycle). 

Vérification de la matrice 

Cliquer sur un capillaire dans le tableau afin d'afficher les résultats 
correspondants (données spectrales, valeur de qualité et nombre condition) 
sous le tableau des résultats du cycle. 

 La valeur de qualité (Q) de chaque capillaire doit être supérieure à 0,8 et 
le nombre condition (C) doit être compris entre 1 et 20. 

 Vérifier que la ligne de base des échantillons de matrice est plane. Comme 
le montre la figure ci-dessous, il doit y avoir 5 pics avec des hauteurs de 
1000 à 5000 RFU pour chaque échantillon de matrice. (Remarque : La 
plage optimale est de 2000 à 4000 RFU.) 

 

 

Électrophérogramme d'étalonnage spectral avec la matrice étalon BT5 sur le 
séquenceur de gènes AB 3500 
 

Lorsque l'étalonnage spectral réussi, les résultats s'affichent en vert dans la 
rangée « Overall » (Résultats globaux). Si les résultats s'affichent en rouge, 
consulter la section consacrée au dépannage lors de l'étalonnage spectral du 
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Guide d'utilisation des séquenceurs de gènes Applied Biosystems 3500/3500xL 
(Applied Biosystems 3500/3500xL Genetic Analyzers User Guide). 
 

 
Exemple d'étalonnage spectral réussi avec la matrice étalon BT5 pour tous les 
capillaires du séquenceur de gènes AB 3500.  

Pour chaque capillaire, sélectionner et afficher les données spectrales et les 
données brutes. Vérifier qu'elles respectent les critères suivants : 

 L'ordre des pics sur le profil spectral est, de gauche à droite : orange, 
rouge, jaune, vert, bleu. 

 Aucun pic étranger n'apparaît sur le profil des données brutes. 

 La morphologie des pics du profil spectral ne présente pas de 
chevauchement, de fléchissement ni d'autres irrégularités flagrants. Les pics 
sont séparés et bien distincts. 

Si les données pour tous les capillaires satisfont les critères ci-dessus, cliquer sur 
« Accept Results » (Accepter les résultats). Si les données d'un capillaire 
quelconque ne satisfont pas aux critères ci-dessus, cliquer sur « Reject Results » 
(Rejeter les résultats) et consulter la section consacrée au dépannage lors de 
l'étalonnage spectral du Guide d'utilisation des séquenceurs de gènes Applied 
Biosystems 3500/3500xL (Applied Biosystems 3500/3500xL Genetic Analyzers 
User Guide). 

Préparation des échantillons 

1. Préparer un mélange de formamide et d'ADN étalon de taille comme 
indiqué au Tableau 35. 
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Tableau 35. Préparation du mélange de formamide et d'ADN étalon de 
taille 

Composant Volume par 
échantillon 

Formamide Hi-Di 12,0 μl 

ADN étalon de taille 550 (BTO) 0,5 μl 
 

 
2. Pour chaque échantillon à analyser, transférer une aliquote de 

mélange de 12 μl dans un tube. 
3. Ajouter 1 μl de produit de PCR ou d'échelle allélique (dilués, si 

nécessaire). 
4. Dénaturer pendant 3 min à 95 °C. 
5. Congeler ultrarapidement en plaçant la plaque sur de la glace 

pendant 3 min. 
Le thermocycleur réglé à 4 °C peut également servir à refroidir la plaque. 

6. Charger les échantillons sur le plateau. 
 
Dans la mesure où les injections ont lieu au même moment pour tous les 
capillaires, 8 ou 24 échantillons doivent être pipetés dans la plaque des 
séquenceurs multicapillaires. Si le nombre d'échantillons analysés est inférieur, 
il est impératif de remplir les positions vides avec 12 μl de formamide Hi-Di. 

Afin d'assurer la fiabilité de la localisation des allèles avec les séquenceurs 
multicapillaires, injecter une échelle allélique pour chaque ensemble de 
24 échantillons : 

 Appareils à 8 capillaires : une échelle allélique pour 3 injections 

 Appareils à 24 capillaires : une échelle allélique pour une injection  

La température ambiante peut affecter la performance des produits de PCR sur 
les séquenceurs multicapillaires, générant des épaulements ou des 
dédoublements de pics, en particulier à basse température. Veiller à maintenir 
des conditions ambiantes conformes aux recommandations du fabricant de 
l'appareil. 

Configuration d'un cycle 

Lors de la première utilisation d'un kit Investigator ESSplex Plus sur un 
séquenceur de gènes Applied Biosystems 3500, un certain nombre de 
protocoles doivent d'abord être configurés :  
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 Protocole spécifique de l'appareil 

 Étalon de taille 

 Protocole QC 

 Analyse 

Tous les protocoles peuvent être configurés par l'intermédiaire du tableau de 
bord du logiciel 3500 Series Data Collection. 

1. Pour configurer le protocole spécifique de l'appareil, aller dans 
« Library » et sélectionner « Analyze » puis « Instrument Protocols » 
(Protocoles de l'appareil) et cliquer sur « Create ». 

2. Les paramètres indiqués au Tableau 36 doivent être saisis ou 
sélectionnés. 
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Tableau 36. Paramètres du protocole spécifique à l'appareil pour 
séquenceur AB 3500 

Paramètre Valeur 

« Application Type » « HID » (Identification humaine) 

« Capillary Length » 
(Longueur des capillaires) 

36 cm 

« Polymer » POP4 

« Dye Set » par exemple, BT5 

« Run Module » HID36_POP4 

« Protocol Name » (Nom du 
protocole) 

par exemple, Investigator ESSplex 
Plus 

« Oven Temperature » (°C) Par défaut 

« Run Voltage » (kV) : Par défaut  

« Pre-Run Voltage » (kV) Par défaut 

« Injection Voltage » (kV) 3,0 

« Run Time » (s) 1300* 

« PreRun Time » (s) Par défaut 

« Injection Time » (s)  8,0† 

« Data Delay » (Délai 
d'attente des données) (s) 

Par défaut 

« Advanced Options » 
(Options avancées) 

Par défaut 

 

* Selon les conditions d'analyse, la durée du cycle avec le kit Investigator ESSplex Plus a été 
modifiée pour pouvoir analyser des fragments d'une longueur maximale de 500 pb.  

† En s'écartant des paramètres standard, la durée d'injection peut être comprise entre 1 et 20 s 
selon le type d'échantillon. Si des échantillons présentent un signal très intense, il est possible 
de sélectionner une durée d'injection plus courte. Dans le cas d'échantillons à faible teneur 
en ADN, une durée d'injection allant jusqu'à 20 s peut être nécessaire. 

 
3. Cliquer sur « Save » pour confirmer les modifications. 
4. Pour configurer l'étalon de taille, aller dans « Library » et 

sélectionner « Analyze » puis « Size Standards » (Étalons de taille) et 
cliquer sur « Create ». 
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5. Les paramètres indiqués au Tableau 37 doivent être saisis ou 
sélectionnés. 
Il convient d'utiliser l'ADN étalon de taille 550 (BTO) avec les longueurs de 
fragments suivantes : 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 
240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 
525 et 550 bp. 

Tableau 37. Paramètres de l'étalon de taille 

Paramètre Valeur 

« Size Standard » par exemple, BTO_550 

« Dye Color » (Couleur du colorant) « Orange » 
 

 
6. Cliquer sur « Save » pour confirmer les modifications. 
7. Pour configurer le protocole de contrôle qualité, aller dans 

« Library » et sélectionner « Analyze » puis « QC Protocols » 
(Protocoles QC) et cliquer sur « Create ». 

8. Les paramètres indiqués au Tableau 38 doivent être saisis ou 
sélectionnés. 

Tableau 38. Paramètres du protocole de contrôle qualité 

Paramètre Valeur 

« Protocol Name » par exemple, BTO_550 

« Size Standard » SST-BTO_60-500bp (étape 4) 

« Sizecaller » SizeCaller v1.1.0 
 

 
9. Aller à « Analysis Settings » (Paramètres d'analyse) puis « Peak 

Amplitude Threshold » (Seuil d'amplitude des pics) et désactiver la 
couleur violette. Vérifier que toutes les autres couleurs sont activées. 
Toutes les autres paramètres doivent conserver leur valeur par défaut. 

10. Cliquer sur « Save » pour confirmer les modifications. 
11. Pour configurer le protocole d'analyse, aller dans « Library » et 

sélectionner « Manage » (Gérer) puis « Assays » (Analyses) et cliquer 
sur « Create ». 
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12. Pour analyser les fragments du kit Investigator ESSplex Plus, les 
paramètres indiqués au Tableau 39 doivent être sélectionnés. 

Tableau 39. Paramètres d'analyse 

Paramètre Valeur 

« Assay Name » (Nom de 
l'analyse) 

par exemple, Investigator ESSplex Plus 

« Color » (Couleur) Par défaut 

« Application Type » « HID » 

« Instrument Protocol » par exemple, Investigator ESSplex Plus 
(étape 1) 

« QC Protocols » par exemple, BTO_550 (étape 4) 
 

 

13. Cliquer sur « Save » pour confirmer les modifications. 

Démarrage du cycle 

1. Dans le tableau de bord, cliquer sur « Create New Plate » (Créer 
nouvelle plaque).  

2. Aller à « Define Plate Properties » (Définir les propriétés de la 
plaque) et sélectionner « Plate Details » (Détails de la plaque). 
Sélectionner ou saisir les paramètres fournis au Tableau 40. 

Tableau 40. Propriétés de la plaque 

Propriété Valeur 

« Name » par exemple, Investigator ESSplex Plus 

« Number of Wells » (Nombre de 
puits) 

96, 96-FastTube ou 384 

« Plate Type » « HID » 

« Capillary Length » 36 cm 

« Polymer » POP4 
 

 

3. Cliquer sur « Assign Plate Contents » (Attribuer le contenu de la 
plaque) pour confirmer les modifications. 
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4. Saisir le nom de l'échantillon correspondant dans chacun des puits 
contenant un échantillon ou une échelle allélique. Cette opération 
permet d'identifier les positions des puits de chaque échantillon à 
des fins de collecte et de traitement des données. 

5. Sélectionner la valeur « Assay » adaptée. Si les étapes de la rubrique 
Configuration d'un cycle ont été suivies, il s'agit de l'Investigator 
ESSplex Plus de l'étape 11. Une analyse doit être attribuée à tous les 
puits nommés de la plaque.  

6. Sélectionner les puits pour lesquels spécifier une analyse. Cocher la 
case en regard du nom d'une analyse pour l'attribuer aux puits 
sélectionnés.  

7. (Facultatif) Répéter l'opération pour les conventions de nom de fichiers 
et le groupe de résultats. 

8. Si ce n'est déjà fait, charger la plaque assemblée sur l'appareil et 
fermer la porte de celui-ci pour le réinitialiser. Cliquer ensuite sur 
« Link Plate for Run » (Lier la plaque pour le cycle). Dans l'écran 
suivant, renseigner le champ Run Name (Nom de cycle) et cliquer 
sur « Start Run ». 
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Paramètres et méthode d'analyse 
Tableau 41 dresse la liste des paramètres d'analyse recommandés pour la fiche 
de travail Peak Detector (Détecteur de pics). 

Tableau 41. Paramètres recommandés pour le séquenceur Applied 
Biosystems 3500/3500xL 

Paramètre Valeur 

« Peak Detection Algorithm » « Advanced » 

« Ranges » « Analysis » : « Partial Range » 

« Start Point » : 1 000 ; « Stop Point » : 20 000 

« Sizing » : « All Sizes » 

« Smoothing and Baselining » « Smoothing » : « Light »  

« Baseline Window » : 51 pt 

« Size Calling Method » « Local Southern Method » 

« Peak Detection » « Peak Amplitude Thresholds » 

B :*    Y :* 

G :*   R :* 

O :* 

« Min. Peak Half Width » : 2 pt 

« Polynomial Degree » : 3 

« Peak Window Size » : 11 pt† 

« Slope Thresholds » : 0,0 
 

* Le seuil d'amplitude des pics (valeur seuil) correspond à la hauteur minimale de pic détectée 
par le logiciel GeneMapper ID-X, version 1.2. Les seuils sont généralement de 50 à 200 RFU 
et il revient au laboratoire de les déterminer individuellement. Recommandation : Il convient 
que la hauteur minimale de pic soit trois fois plus élevée que le bruit de fond de la ligne de 
base. 

† Seul le paramètre Peak Window Size diffère des valeurs par défaut d'Applied Biosystems pour 
l'analyse d'identification humaine. 
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Protocole : Analyse 
Pour des instructions générales sur l'analyse automatique des échantillons, 
consulter le Guide d'utilisation du logiciel GeneScan, GeneMapper ID, ou 
GeneMapper ID-X. 

Pour l'analyse à l'aide du logiciel QIAGEN Investigator IDproof ou IDproof 
Mixture, consulter les guides d'utilisation et de flux de travail correspondants. 

La détermination de la longueur exacte des amplicons dépend du type 
d'appareil, des conditions d'électrophorèse ainsi que de l'ADN étalon de taille 
utilisé. En raison de la complexité de certains loci, il convient de baser la 
détermination de la taille sur des références réparties uniformément. Il convient 
d'utiliser l'ADN étalon de taille 550 (BTO) avec les longueurs de fragments 
suivantes : 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 240, 250, 260, 
280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 525 et 550 bp. 
 

 
Figure 1. Électrophérogramme de l'ADN étalon de taille 550 (BTO), longueur des 
fragments en pb. 

Fichiers de modèles Investigator 
Il convient de procéder à la localisation des allèles à l’aide d’un logiciel 
d’analyse adapté, par exemple QIAGEN Investigator IDproof ou IDproof 
Mixture ou GeneMapper ID Genotyper en association avec les fichiers de 
modèles Investigator disponibles au téléchargement à partir de 
www.qiagen.com ou sur CD(cat. no. 389900) voir Tableau 42 et Tableau 43. 

Le fichier de modèle Investigator recommandé pour le logiciel Genotyper est le 
fichier ESSplex. 
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Tableau 42. Fichiers de modèles Investigator recommandés pour 
GeneMapper ID 

Type de fichier Nom de fichier 

« Panels » ESSplex_Panels 

« BinSets » ESSplex_Bins 

« Size Standard » SST-BTO_60–500bp 

« Analysis Method » Analysis_HID_310 

Analysis_HID_3130 

Analysis_HID_310_50rfu 

Analysis_HID_3130_50rfu 

« Plot Settings » (Paramètres 
de tracé) 

Plots_5dyes 

« Table Settings » (Paramètres 
de tableau) 

« Table for 2 alleles » (Tableau pour 2 allèles) 

« Table for 10 alleles » (Tableau pour 
10 allèles) 

 

Les fichiers panels et BinSets doivent toujours être utilisés tandis que les autres fichiers de 
modèles sont facultatifs. 
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Tableau 43. Fichiers de modèles Investigator recommandés pour 
GeneMapper ID-X 

Type de fichier Nom de fichier 

« Panels » ESSplex_Panels_x 

« BinSets » ESSplex_Bins_x 

« Stutter » (Bégaiement) ESSplex_Stutter_x 

« Size Standard » SST-BTO_60–500bp 

« Analysis Method » Analysis_HID_310 

Analysis_HID_3130 

Analysis_HID_310_50rfu 

Analysis_HID_3130_50rfu 

Analysis_HID_3500 

« Plot Settings » Plots_5dyes 

« Table Settings » « 310 Data Analysis/31xx Data Analysis 
(ABI) » (Analyse des données 310/31xx (ABI)) 

 

Les fichiers panels et BinSets doivent toujours être utilisés tandis que les autres fichiers de 
modèles sont facultatifs.  

Témoins 
Les allèles cités au Tableau 44 représentent l'ADN témoin XY13 (inclus dans le 
kit Investigator ESSplex Plus) et l'ADN d'autres souches cellulaires normalisées 
disponibles dans le commerce. 
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Tableau 44. Localisation des allèles du kit Investigator ESSplex Plus 

Locus ADN 
témoin 
XY13 

CCR 
9948 

CCR 
9947A 

ATCC 
K-562 

CCR 
3657 

Amélogénine X/Y X/Y X/X X/X X/Y 

D1S1656 16/17.3 14/17 18.3/18.3 15/16 13/18.3 

D2S441 10/11 11/12 10/14 10/14 14/14 

D2S1338 17/23 23/23 19/23 17/17 18/22 

D3S1358 15/16 15/17 14/15 16/16 16/18 

D8S1179 13/14 12/13 13/13 12/12 15/16 

D10S1248 14/15 12/15 13/15 12/12 14/16 

D12S391 16/18 18/24 18/20 23/23 18/19 

D16S539 11/12 11/11 11/12 11/12 13/13 

D18S51 14/15 15/18 15/19 15/16 12/20 

D19S433 13/14 13/14 14/15 14/14.2 13/14 

D21S11 28.2/33.2 29/30 30/30 29/30/31 28/29 

D22S1045 17/18 16/18 11/14 16/16 11/17 

FGA 22/23 24/26 23/24 21/24 18/23 

THO1 6/7 6/9.3 8/9.3 9.3/9.3 7/9.3 

vWA 15/16 17/17 17/18 16/16 14/19 
 

 

Pour confirmation, le tableau ci-dessus affiche les allèles d'ADN de référence 
achetés auprès d'ATCC (http://atcc.org/Produtcs/PurifiedDNA.cfm#celllines) 
ainsi que de trois ADN de référence achetés auprès de Coriell Cell Repositories 
(CCR, http://locus.umdnj.edu/nigms/) conformes à l'article de Szibor et al. 
(2003). 

Allèles 
Le Tableau 45 indique les allèles de l'échelle allélique. Toutes les analyses ont 
été réalisées avec le polymère POP-4 (Figure 2 et Figure 3). Des séquenceurs, 
des ADN étalons de taille et des polymères différents peuvent donner des 
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longueurs différentes. En outre, un alignement visuel sur l'échelle allélique est 
recommandé. 

Échelle 

 Horizontale : 70 à 480 pb  

 Verticale : selon l'intensité des signaux  
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Tableau 45. Fragments de l'échelle allélique inclus dans le kit 
Investigator ESSplex Plus 

Locus Colorant 
marqué 

Nombres de répétitions de l'échelle allélique 

Amélogénine 6-FAM X, Y 

TH01 6-FAM 4, 5, 6, 7, 8, 9, 9.3, 10, 10.3, 13, 13.3 

D3S1358 6-FAM 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21 

vWA 6-FAM 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22 

D21S11 6-FAM 
24, 24.2, 25, 26, 26.2, 27, 28, 28.2, 29, 29.2, 
30, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35, 
36, 36.2, 37 

D16S539 BTG 8, 9, 10, 11, 12, 13, 14, 15 

D1S1656 BTG 10, 11, 12, 13, 14, 15, 16, 17, 17.3, 18.3, 19.3 

D19S433 BTG 6.2, 10, 11, 12, 12.2, 13, 13.2, 14, 14.2, 15, 
15.2, 16, 16.2, 17, 17.2 

D8S1179 BTG 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 

D2S1338 BTG 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 
28 

D10S1248 BTY 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 

D22S1045 BTY 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 

D12S391 BTY 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26 

FGA BTY 14, 16, 17, 18, 19, 20, 21, 21.2, 22, 23, 23.2, 
24, 25, 26, 27, 28, 29, 30, 31.2, 33, 34, 37.2, 
42.2, 44.2, 45.2, 47.2, 50.2 

D2S441 BTR 8, 9, 10, 11, 11.3, 12, 13, 14, 15, 16, 

D18S51 BTR 8, 9, 10, 10.2, 11, 12, 13, 14, 15, 16, 17, 17.2, 
18, 18.2, 19, 20, 21, 21.2, 23, 24, 25, 26, 27, 
28 

 
 

Pour en savoir plus sur les microvariants non inclus dans l'échelle allélique du 
kit Investigator ESSplex Plus, consulter le site Web du NIST (National Institute of 
Standards and Technology) à l'adresse www.cstl.nist.gov/biotech/strbase/. 
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Figure 2. Électrophérogramme du kit Investigator ESSplex Plus avec 500 pg d'ADN 
témoin XY13. L'analyse a été réalisée sur le séquenceur de gènes Applied Biosystems 3500. 
La localisation des allèles a été réalisée à l'aide du logiciel Investigator IDproof. 
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Figure 3. Électrophérogramme de l'échelle allélique ESSplex Plus analysée sur le 
séquenceur de gènes ABI PRISM 310. La localisation des allèles a été réalisée à l'aide du 
logiciel GeneMapper ID et du fichier de modèles Investigator ESSplex Plus. 
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Interprétation des résultats 
L'analyse post-PCR et la localisation automatique des allèles à l'aide d'un 
logiciel d'analyse adapté permet une discrimination allélique précise et fiable. 

Procédure générale d'analyse 

1. Vérifier l'ADN étalon de taille. 
2. Vérifier l'échelle allélique. 
3. Vérifier le témoin positif. 
4. Vérifier le témoin négatif. 
5. Analyser les échantillons et interpréter les données. 

Pics de remontée 

Des pics de remontée peuvent apparaître si la hauteur des pics se trouve en 
dehors de la plage de détection linéaire (> 4000 RFU pour le séquenceur 310 
ou 5000 RFU pour les séquenceurs 3100, 3130 et 3500) ou en cas 
d'application d'une matrice incorrecte. Ils apparaissent à des positions 
spécifiques dans les voies des autres couleurs, généralement avec une intensité 
de signal plus faible. Afin d'éviter leur apparition, la hauteur des pics ne doit 
pas dépasser 3000 RFU.  

Pics de bégaiement 

L'apparition de pics de bégaiement dépend de la séquence de la structure répétée 
et du nombre d'allèles. Les pics n-4 sont dus à la perte d'une unité répétée au 
cours de l'amplification de motifs tétranucléotidiques de marqueurs microsatellites 
en raison des effets de dérapage de l'ADN polymérase Taq tandis que les pics n-
3 apparaissent en particulier pendant l'amplification du motif trinucléotidique 
du marqueur D22S1045. Il convient d'interpréter ces pics à l'aide des fichiers de 
modèles Investigator pour le logiciel Genotyper, GeneMapper ID ou 
GeneMapper ID-X. 

Addition nucléotidique indépendante du modèle 

En raison de l'activité de la transférase terminale, l'ADN polymérase Taq peut 
entraîner une adénylation incomplète à l'extrémité 3' des fragments d'ADN 
amplifiés. Ce pic interférent est plus court d'une base que le pic attendu (pics –1). 
Toutes les amorces du kit Investigator ESSplex Plus sont conçues pour minimiser 
ces interférences. La hauteur des pics interférents est proportionnelle à la quantité 
d'ADN. Il revient aux laboratoires de définir leurs propres limites pour l'analyse 
de ces pics. 
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Interférences  

La température ambiante peut affecter la performance des produits de PCR sur 
les séquenceurs multicapillaires, générant des épaulements ou des 
dédoublements de pics. En cas d'apparition de tels phénomènes, il est 
recommandé de réinjecter l'échantillon. 
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Résolution des principaux problèmes rencontrés 
Ce guide de résolution des principaux problèmes rencontrés peut aider à 
répondre à certaines questions qui peuvent se poser. Pour plus d’informations, 
voir aussi la page Foire aux Questions de notre Centre d’assistance technique : 
www.qiagen.com/FAQ/FAQList.aspx. Les scientifiques des Services techniques 
de QIAGEN seront ravis de répondre à toutes les questions sur les informations 
et protocoles figurant dans ce manuel ou sur les technologies d'échantillons et 
d'analyses (pour les coordonnées, voir quatrième de couverture ou le site 
www.qiagen.com). 

 Commentaires et suggestions 

Préparation des échantillons  

L'intensité du signal de 
l'échantillon doit être 
augmentée. 

Réduire le volume d'ADN étalon de taille 550 
(BTO) de manière à obtenir des pics d'environ 
500 RFU de haut.  

Purifier les produits de PCR avant de commencer 
l'analyse. Pour une purification rapide et efficace, 
il est recommandé d'utiliser le kit MinElute® PCR 
Purification (voir la rubrique Pour commander). 

Matrice ou étalonnage spectral inadaptés 

 Avec la matrice et 
l'étalonnage spectral 
actuels, des pics de 
remontée entre les 
panels de colorants (B, 
G, Y, R, O) sont 
observés. 

Cette matrice ne peut pas être utilisée pour 
l'analyse. Répéter la génération de la matrice et 
l'étalonnage spectral. Veiller à suivre 
scrupuleusement le protocole adapté au 
séquenceur utilisé. 

Marquage de nombreux pics d'échantillons comme des allèles situés 
en dehors de l'échelle 

a) L'ADN étalon de taille 
550 (BTO) n'a pas été 
bien défini ou identifié. 

Dans la barre d'outils supérieure du logiciel 
GeneMapper ID ou GeneMapper ID-X, cliquer 
sur l'icône orange « Size Match Editor » (Éditeur 
d'appariement des tailles). Noter les fragments 
orange de tous les échantillons.  

Toujours utiliser l'ADN étalon de taille 550 inclus 
dans les kits de PCR d'identification humaine 
Investigator. 
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 Commentaires et suggestions 

b) L'intensité des signaux 
est trop élevée. Si la 
hauteur des pics des 
échantillons se trouve 
en dehors de la plage 
de détection linéaire 
(> 4000 RFU pour l'ABI 
310, > 5000 RFU pour 
l'ABI 3100, 3130 et 
3500), il se peut que les 
pics de bégaiement, les 
pics dédoublés et les 
interférences soient plus 
importants. 

Réduire la durée d'injection par incréments 
jusqu'à un minimum d'1 s, réduire la quantité 
d'amplicons pour l'analyse ou réduire la quantité 
d'ADN pour la PCR. 

c) La présence de bulles 
dans le capillaire 
entraîne des pics de 
remontée dans les 
panels de couleurs 
(traversée) et ainsi une 
mauvaise localisation 
d'allèles. 

Répéter l'électrophorèse pour confirmer les 
résultats. 

d) Les différences de 
performances du cycle 
entre les capillaires 
d'un séquenceur 
multicapillaire peuvent 
entraîner un décalage 
dans la localisation des 
allèles. 

Afin d'assurer la fiabilité de la localisation des 
allèles avec les séquenceurs multicapillaires, il 
convient d'utiliser plusieurs échelles alléliques. 
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 Commentaires et suggestions 

Injection ou fichier d'échelle allélique inadaptés 

a) Un signal 
supplémentaire peut 
être identifié comme un 
pic de l'échelle 
allélique en raison d'un 
dysfonctionnement au 
cours de 
l'électrophorèse. Si les 
pics de l'échelle 
allélique ne sont pas 
correctement appelés, 
cette échelle ne peut 
pas être utilisée pour 
l'analyse. 

Utiliser une autre injection ou un autre fichier 
d'échelle allélique et vérifier les données de taille 
des fragments de l'échelle allélique déterminées 
à l'aide de l'étalon de taille (en pb).  

Toujours utiliser l'ADN étalon de taille 550 avec 
les kits de PCR d'identification humaine 
Investigator. 

b) Un pic de l'échelle 
allélique se trouve en 
dessous du seuil de 
détection (50 à 
200 RFU) de la 
méthode d'analyse 
employée et n'est donc 
pas identifié. 

L'échelle allélique doit être chargée sur 
l'analyseur à une concentration supérieure à 
celle des échantillons à analyser.  

Il est également possible d'analyser les données 
de l'échelle allélique en définissant un seuil de 
détection des pics inférieur dans le logiciel 
d'analyse. 

c) Un pic de l'échelle 
allélique n'est pas 
identifié car il se trouve 
en dehors de la plage 
de tailles attendues 
définie dans le logiciel 
(en pb). 

Comparer la longueur des fragments (en pb) du 
premier allèle pour une couleur de l'échelle 
allélique avec la valeur correspondante des 
catégories. La comparer ensuite à celle des 
autres allèles. 

d) Les allèles 
fractionnaires sont 
introuvables. 

Les allèles fractionnaires sont des allèles 
présentant une différence d'au moins 1 pb avec 
l'allèle entier suivant. Vérifier les paramètres de 
la méthode d'analyse. Réduire la valeur du 
paramètre Peak Window Size à 11 points. 
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Références 
QIAGEN tient à jour une grande banque de données en ligne de publications 
scientifiques utilisant les produits QIAGEN. Des critères de sélection de 
recherche aident à trouver les articles à l’aide d’un mot-clé ou en spécifiant 
l’application, le domaine de recherche, le titre, etc. 

Pour une liste complète des références, visiter notre banque de données en 
ligne « QIAGEN Reference Database » à l’adresse 
www.qiagen.com/RefDB/search.asp ou bien contacter les services techniques 
de QIAGEN ou le distributeur local. 
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Pour commander  
Produit Contenu Référence 

Investigator ESSplex 
Plus Kit (100) 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381535 

Investigator ESSplex 
Plus Kit (400) 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381537 

Produits assimilés  

Kits pour PCR pour l'identification humaine Investigator  

Investigator ESSplex 
Kit (100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381515 

Investigator ESSplex 
SE Kit (100)*  

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381525 

Investigator 
Nonaplex ESS Kit 
(100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381315 

Investigator 
Hexaplex ESS Kit 
(100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

380615 

Investigator HDplex 
Kit (25)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381213 

 
* Des kits plus grands sont disponibles, nous contacter pour en savoir plus. 
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Investigator Argus X-
12 Kit (25)* 

Mélange d'amorces, mélange 
réactionnel, ADN témoin XX28, ADN 
polymérase Multi Taq2, ADN étalon 
de taille 550 (BTO), échelle allélique 
Argus X-12 et eau exempte de 
nucléase 

383213 

Investigator Argus Y-
12 QS Kit (100)* 

Mélange d'amorces avec témoin 
interne (QS), mélange réactionnel, 
ADN témoin XY1, ADN témoin XX, 
ADN étalon de taille 550 (BTO), 
échelle allélique Argus Y-12 QS et eau 
exempte de nucléase 

383615 

Investigator IDplex 
Kit (100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

381615 

Investigator Triplex 
AFS QS Kit (100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

380315 

Investigator Triplex 
DSF Kit (100)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

380325 

Investigator DIPplex 
Kit (25)* 

Mélange d'amorces, mélange 
réactionnel, ADN polymérase, ADN 
témoin, échelle allélique, ADN étalon 
de taille et eau exempte de nucléase 

384013 

Investigator 
Quantiplex Kit (200) 

Mélange d'amorces IC FQ, mélange 
réactionnel FQ, ADN témoin Z1, 
tampon de dilution 

387016 

Investigator 
Template Files  

Tous les fichiers de modèles des kits 
pour PCR pour identification humaine 
Investigator à utiliser avec les logiciels 
GeneMapper ID, GeneMapper ID-X et 
Genotyper ainsi qu'avec le logiciel 
gratuit DIPSorter (CD-ROM) 

389900 

 
* Des kits plus grands sont disponibles, nous contacter pour en savoir plus. 
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Matrix Standard BT5 
single cap. (5 x 25) 

Matrice étalon 6-FAM, BTG, BTY, BTR 
et BTO 

386113 

Matrix Standard BT5 
multi cap. (25) 

Matrice étalon 6-FAM, BTG, BTY, BTR 
et BTO 

386123 

Matrix Standard BT5 
multi cap. (50) 

Matrice étalon 6-FAM, BTG, BTY, BTR 
et BTO 

386125 

Extraction et purification d'ADN  

QIAamp® DNA 
Investigator Kit (50) 

50 colonnes QIAamp MinElute, 
protéinase K, ARN entraîneur, 
tampons, tubes de prélèvement (2 ml) 

56504 

EZ1® DNA 
Investigator Kit (48) 

Cartouches de réactifs (DNA 
Investigator), cônes munis de filtre 
jetables, porte-cônes jetables, tubes 
d’échantillon (2 ml), tubes d'élution 
(1,5 ml), tampon G2, protéinase K, 
ARN entraîneur 

952034 

MinElute PCR 
Purification Kit (50)* 

50 colonnes MinElute Spin, tampons, 
tubes de prélèvement (2 ml) 

28004 

 

Pour obtenir les dernières informations sur la licence et les clauses de 
responsabilité spécifiques aux produits, consulter le manuel du kit ou le manuel 
d'utilisation QIAGEN respectifs. Les manuels des kits et manuels d'utilisation 
QIAGEN sont disponibles à l'adresse www.qiagen.com ou peuvent être 
demandés auprès des Services techniques QIAGEN ou du distributeur local. 
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Marques de commerce : QIAGEN®, QIAamp®, EZ1®, Investigator®, MinElute®, Rotor-Gene® (QIAGEN Group), ABI PRISM®, Applied Biosystems®, 
GeneAmp®, GeneMapper®, GeneScan®, Genotyper®, 6-FAM™, Hi-Di™, POP-4™ (Life Technologies Corporation), Eppendorf®, Mastercycler® 
(Eppendorf AG), GenBank ® (US Department of Health and Human Services). 

Accord de licence limitée 

En utilisant ce produit, l’acheteur ou l’utilisateur du kit Investigator ESSplex Plus consent aux termes suivants : 

1. Le kit Investigator ESSplex Plus ne doit être utilisé que conformément au Manuel du kit Investigator ESSplex Plus et avec les composants fournis à 
l’intérieur du kit. QIAGEN n’accorde aucune licence sous sa propriété intellectuelle pour utiliser ou intégrer les composants fournis dans ce kit 
avec tout autre composant non fourni dans ce kit, à l’exception de ce qui est stipulé dans le Manuel du kit Investigator ESSplex Plus et autres 
protocoles disponibles sur le site www.qiagen.com. 

2. Hormis les licences énoncées expressément, QIAGEN n’offre aucune garantie indiquant que ce kit et/ou son(ses) utilisation(s) ne violent pas les 
droits de tiers. 

3. Ce kit et ses composants sont sous licence pour une utilisation unique et ne peuvent pas être réutilisés, remis à neuf ou revendus. 

4. QIAGEN rejette notamment toutes autres licences, expresses ou tacites, autres que celles énoncées expressément. 

5. L’acheteur et l’utilisateur du kit consentent à ne pas prendre, ni autoriser quiconque à prendre, de quelconques mesures pouvant entraîner ou 
faciliter la réalisation d’actes interdits par les termes précédents. QIAGEN peut faire appliquer des interdictions de cet Accord de licence limitée 
par tout tribunal et pourra recouvrir tous ses frais de recherche et de justice, y compris les frais d’avocats, en cas d’action en application de cet 
Accord de licence limitée ou de tous ses droits de propriété intellectuelle liés au kit et/ou à ses composants. 

Pour les termes de licence mis à jour, voir www.qiagen.com. 

© 2011 QIAGEN, tous droits réservés. 
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www.qiagen.com 

Australia  Orders 1-800-243-800  Fax 03-9840-9888  Technical 1-800-243-066 

Austria  Orders 0800-28-10-10  Fax 0800-28-10-19  Technical 0800-28-10-11 

Belgium  Orders 0800-79612  Fax 0800-79611  Technical 0800-79556 

Brazil  Orders 0800-557779  Fax 55-11-5079-4001  Technical 0800-557779 

Canada  Orders 800-572-9613  Fax 800-713-5951  Technical 800-DNA-PREP (800-362-7737) 

China  Orders 86-21-3865-3865  Fax 86-21-3865-3965  Technical 800-988-0325 

Denmark  Orders 80-885945  Fax 80-885944  Technical 80-885942 

Finland  Orders 0800-914416  Fax 0800-914415  Technical 0800-914413 

France  Orders 01-60-920-926  Fax 01-60-920-925  Technical 01-60-920-930  Offers 01-60-920-928 

Germany  Orders 02103-29-12000  Fax 02103-29-22000  Technical 02103-29-12400 

Hong Kong  Orders 800 933 965  Fax 800 930 439  Technical 800 930 425 

Ireland  Orders 1800 555 049  Fax 1800 555 048  Technical 1800 555 061 

Italy  Orders 800-789-544  Fax 02-334304-826  Technical 800-787980 

Japan  Telephone 03-6890-7300  Fax 03-5547-0818  Technical 03-6890-7300 

Korea (South)  Orders 080-000-7146  Fax 02-2626-5703  Technical 080-000-7145 

Luxembourg  Orders 8002-2076  Fax 8002-2073  Technical 8002-2067 

Mexico  Orders 01-800-7742-639  Fax 01-800-1122-330  Technical 01-800-7742-436 

The Netherlands  Orders 0800-0229592  Fax 0800-0229593  Technical 0800-0229602 

Norway  Orders 800-18859  Fax 800-18817  Technical 800-18712 

Singapore  Orders 1800-742-4362  Fax 65-6854-8184  Technical 1800-742-4368 

Spain  Orders 91-630-7050  Fax 91-630-5145  Technical 91-630-7050 

Sweden  Orders 020-790282  Fax 020-790582  Technical 020-798328 

Switzerland  Orders 055-254-22-11  Fax 055-254-22-13  Technical 055-254-22-12 

UK  Orders 01293-422-911  Fax 01293-422-922  Technical 01293-422-999 

USA  Orders 800-426-8157  Fax 800-718-2056  Technical 800-DNA-PREP (800-362-7737) 


